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Copyright
Copyright © 2010 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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For your safety

QUALIFIED SERVICE
Only qualified personnel may install or repair phone equipment.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do not connect incompatible products.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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Company policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Li-Ion batteries, discharge the battery from time to time by leaving the product
switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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  Product selection
RM-645 is a HSDPA/HSUPA/WCDMA/GSM handportable phone with a monoblock form factor and A-GPS support.
It supports EGSM850/900/1800/1900 and WCDMA900/2100 bands, and GPRS/EGPRS, WCDMA/HSDPA/HSUPA
data bearers.

For WCDMA the maximum bit rate is up to 384 kbit/s for downlink and 384 kbit/s for uplink with simultaneous
CS speech or CS video (max. 64 kbit/s). The HSDPA peak is 10.2 Mbps and HSUPA peak is 2 Mbps (with limited
use cases).

For GPRS/EGPRS networks, RM-645 is a Class B EGPRS MSC 32 (5 Rx + 3 Tx, max sum 6), which means a maximum
upload speed of up to 298 kbit/s with EGPRS, and download speed of up to 178.8 kbit/s with GPRS. The device
also supports Dual Transfer Mode (DTM) for simultaneous voice and packet data connection in GSM/EDGE
networks; simple class A, multi slot class 11, (3 Rx + 2Tx), UL/DL=178.8/118.2 kbit/s.

RM-645 is an MMS (Multimedia Messaging Service) enabled multimedia device. The MMS implementation
follows the OMA MMS standard release 1.2. The device also supports Bluetooth 2.0 standard with stereo audio
profiles (A2DP & AVRCP).

RM-645 has a large 2.2’’ QVGA (320 x 240 pixels) display with 16.7 million colors, a 3.2 Megapixel main camera
that has an integrated LED flash and a digital zoom, and a 2nd VGA camera for video calls.

RM-645 uses Symbian 9.3 operating system, S60 (release 3.2) UI, and supports the full Web Browser for S60,
which brings desktop-like Web browsing experience to mobile devices.

RM-645 also supports MIDP Java 2.0, providing a good platform for compelling 3rd party applications.

Figure 1 View of RM-645
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  Product features and sales package

Bearers and transport
• GPRS/EGPRS Class B, Multi slot class 32

• Dual Transfer Mode (DTM) class A, multi slot class 11

• WCDMA DL 384kbit/s, UL 384 kbit/s

• HSDPA up to 10.2Mbps, HSUPA 2Mbps

Connectivity
• Assisted GPS (A-GPS)

• Bluetooth 2.0 with stereo audio profiles (A2DP and AVRCP)

• High Speed USB with micro USB connector

• MicroSD memory card - support up to 16GB

• 3.5 mm AV connector

• 2.0 mm DC connector

• USB charging

Display
• Large 2.2’’ QVGA (320 x 240 pixels) display with 16.7 million colors

Imaging and video
• 3.2 Megapixel EDOF (Extended Depth of Field) camera with a digital zoom, and an integrated LED flash

• 2nd VGA camera for video calls

• Video streaming and sharing

• Horizontal camera mode

• Image capture, recording and zooming by navi key

• Media player with MPEG-4, H. 263 and H.264 support

• Image and video editors

Music
• MP3 player supporting MP3, MP4, AAC, eAAC+ and WMA, progressive download from music player

• Stereo FM Radio

Productivity
Context management

• OMA DRM version 2.0

• PIM (Calendar + Contacts + Active Notes) & Presence enhanced contacts

• OTA provisioning & over the air SW update (FOTA)

• Ovi Suite

• Active Standby

• Local/remote SyncML data sync

• Web Browser (OSS), Java ™ MIDP 2.0, XHTML browsing over TCP/IP

Messaging
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• E-mail (SMTP, IMAP4, POP3)

• SMS, MMS (OMA 1.2)

• Audio Messaging (AMS)

Voice

• Rich Calls: 2-way video conferencing (video call), video sharing

• Voice commands, enhanced voice dialling (SIND)

• Audio message reader for text messages and E-mail

Add-on software framework
• Symbian OS

• Nokia Series 60, 3rd edition, feature pack 3.2

• Java: MIDP2.0

• C++ and Java SDKs

Additional features
• Tutorial

• MP3 and AAC ringing tones, 64 polyphonic, 3D stereo ringing tones, video ringing tones

• Flashlite 2.0

• Vibrating alert

• Speech codec support for AMR, EFR, FR

• Nokia Online Share 4.3 (OVI Share)

• Nokia Maps 3.0

Basic sales package
Basic sales package, there may be sales area variations.

• Transceiver RM-645

• Battery (BL-5CT/1050 mAh)

• Travel charger (AC-8)

• Stereo headset (WH-102)

• Micro USB connectivity cable (CA-101)

• MicroSD card 2GB (MU-37) with pre-loaded maps and OVI Suite 2.0

• Short user guide

  Product and module list

Module name Type code Notes

System/RF module PWB 3FT

UI flex 3FU
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  Mobile enhancements

Table 1 Audio

Enhancement Type

Wired headsets HS-45/AD-44

WH-102 (inbox)

Bluetooth headsets BH-102

Bluetooth headsets (stereo) BH-103

BH-604

Table 2 Car

Enhancement Type

Car kit CK-15W

CK-300 (BT & plug-in)

CK-7W

Holder CR-39

CR-82

CR-115

HH-17

Plug-in car handsfree HF-510

Table 3 Data

Enhancement Type

MicroSD card MU-22, 1 GB

MU-37, 2 GB (inbox)

MU-41, 4 GB

MU-43, 8 GB

MU-44, 16 GB

Connectivity cable CA-101D (inbox)

Table 4 Music

Enhancement Type

Bluetooth speakers MD-7W (BT & plug-in)

Mini speakers MD-9

RM-645
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Table 5 Messaging

Enhancement Type

Wireless keyboard SU-8W

Table 6 Power

Enhancement Type

Battery 1050 mAh Li-ion BL-5CT

Charger AC-6

AC-8 or AC-15 (inbox)

AC-10

  Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T)
(mm)

Weight (g) Volume (cm3)

Transceiver with BL-5CT
1050 mAh Li-ion battery
back

112.3 x 46 x 12.3 95 56.2

Main RF characteristics for GSM850/900/1800/1900 and WCDMA VIII (900) and WCDMA I (2100)
phones

Parameter Unit

Cellular system GSM850, EGSM900, GSM1800/1900, WCDMA VIII
(900) and WCDMA I (2100)

Rx frequency band GSM850: 869 - 894 MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA VIII (900): 925- 960 MHz

WCDMA I (2100): 2110 - 2170 MHz

Tx frequency band GSM850: 824 - 849 MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA VIII (900): 880 - 915 MHz

WCDMA I (2100): 1920 - 1980 MHz
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Parameter Unit

Output power GSM850: +5 ...+33dBm/3.2mW ... 2W

GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA VIII (900): -50 ... +24 dBm/0.01μW ...
251.2mW

WCDMA I (2100): -50 ... +24 dBm/0.01μW ...
251.2mW

EDGE output power EDGE850: +5 … +27dBm/3.2mW … 501mW

EDGE900: +5 … +27dBm/3.2mW … 501mW

EDGE1800: +0 … +26dBm/1.0mW … 400mW

EDGE1900:+0 … +26dBm/1.0mW … 400mW

Number of RF channels GSM850: 124

GSM900: 174

GSM1800: 374

GSM1900: 299

WCDMA VIII (900): 152

WCDMA I (2100): 277

Channel spacing 200 kHz

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16

WCDMA VIII (900): 75

WCDMA I (2100): 75

Environmental conditions

Temperature conditions

Environmental condition Ambient temperature Notes

Normal operation -15oC...+55oC Specifications fulfilled

Reduced performance -25oC...-15oC

+55oC...+70oC

Operational for shorts periods
only

Intermittent operation -40oC...-15oC

+70oC...+85 oC

Operation not guaranteed but an
attempt to operate does not
damage the phone.
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Environmental condition Ambient temperature Notes

No operation or storage <-40oC...>+85oC No storage or operation: an
attempt may damage the phone.

Charging allowed -25oC...+50oC

Long term storage conditions 0oC...+85oC

Humidity
Relative humidity range is 5...95%.

The HW module is not protected against water. Condensed or splashed water might cause malfunction. Any
submersion of the phone will cause permanent damage. Long-term high humidity, with condensation, will
cause permanent damage because of corrosion.

Vibration
The module should withstand the following vibrations:

• 5 - 10 Hz; +10dB / octave

• 10 - 50 Hz; 5.58 m2 / s3 (0.0558 g2/ Hz)

• 50 - 300 Hz; - 10 dB / octave

ESD strength
Conducted discharge is 8 kV (>10 discharges) and air contact 15 kV ( >10 discharges ).

The standard for electrostatic discharge is IEC 61000-4-2, and this device fulfils level 4 requirements.

RoHS
This device uses RoHS compliant components and lead-free soldering process.
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  Service tools

Product specific tools
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-645. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.

FS-150 Flash adapter

For flashing (also dead phones) with SS-46. CU-4 supported.

MJ-276 Module jig

MJ-276 is meant for component level troubleshooting.

The jig includes an RF interface for GSM, WCDMA and Bluetooth. In
addition, it has the following features:

• Provides mechanical interface with the engine module

• Provides galvanic connection to all needed test pads in module

• Multiplexing between USB and FBUS media, controlled by Vusb

• MMC interface

• Duplicated SIM connector

• Connector for control unit

• Access for AV- and USB connectors

• CA-128RS cable is used together with this jig for RF testing

• Attenuation values for galvanic RF connection MJ-276

Band Default f/
MHz RX

Att. RX Default f/
MHz TX

Att. TX

GSM 850 881.6 18.0 836.6 18.0

GSM 900 942.4 18.0 897.4 18.0

GSM 1800 1842.8 24.0 1747.8 24.0

GSM 1900 1960.0 24.0 1880.0 24.0

WCDMA I 2140.0 17.0 1950.0 17.0

WCDMA VIII 942.6 18.0 897.6 18.0
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SA-131 RF coupler

SA-131 is a generic device for GPS testing. It is used together with
SS-62.

General tools
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-645. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.

AC-35 Power supply

Universal power supply for FPS-21; included in the FPS-21 sales
package.

Input 100V…230V 50Hz…60Hz, output voltage of 12 V and output
current up to 3 A.

ACF-8 Universal power
supply

The ACF-8 universal power supply is used to power FLS-5.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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FLS-5 Flash device

FLS-5 is a dongle and flash device incorporated into one package,
developed specifically for POS use.

Note: FLS-5 can be used as an alternative to PK-1.

FPS-21 Flash prommer

FPS-21 sales package:

• FPS-21 prommer

• AC-35 power supply

• CA-31D USB cable

FPS-21 interfaces:

Front
• Service cable connector

Provides Flashbus, USB and VBAT connections to a mobile device.

• SmartCard socket

A SmartCard is needed to allow DCT-4 generation mobile device
programming.

Rear
• DC power input

For connecting the external power supply (AC-35).

• Two USB A type ports (USB1/USB3)

Can be used, for example, for connecting external storage memory
devices or mobile devices

• One USB B type device connector (USB2)

For connecting a PC.

• Phone connector

Service cable connection for connecting Flashbus/FLA.

• Ethernet RJ45 type socket (LAN)

For connecting the FPS-21 to LAN.

Inside
• Four SD card memory slots

For internal storage memory.

Note: In order to access the SD memory card slots inside
FPS-21, the prommer needs to be opened by removing the
front panel, rear panel and heatsink from the prommer body.
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JXS-1 RF shield box

Because the WCDMA network disturbs the RX side testing of the WCDMA
phone and the Tx signal of the WCDMA phone can severely disturb the
WCDMA network, a shield box is needed in all testing, tuning and fault
finding which requires WCDMA RF signal.

The shield box is not an active device, it contains only passive filtering
components for RF attenuation.

PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.

RJ-230 Soldering jig

RJ-230 is a soldering jig used for soldering and as a rework jig for the
engine module.

SB-6 Bluetooth test and
interface box (sales
package)

The SB-6 test box is a generic service device used to perform Bluetooth
bit error rate (BER) testing, and establishing cordless FBUS connection
via Bluetooth. An ACP-8x charger is needed for BER testing and an
AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• SB-6 test box

• Installation and warranty information

SRT-6 Opening tool

SRT-6 is used to open phone covers.

Note: The SRT-6 is included in the Nokia Standard Toolkit.

RM-645
Service Tools and Service Concepts

Issue 1 COMPANY CONFIDENTIAL Page 2 – 9
Copyright © 2010 Nokia. All rights reserved.



SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-21.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• multiplexing between USB and FBUS media, controlled by VUSB

SS-88 Camera removal tool

The camera removal tool SS-88 is used to remove/attach the camera
module from/to the socket.

SS-93 Opening tool

SS-93 is used for opening JAE connectors.

Note: The SS-93 is included in Nokia Standard Toolkit.

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-21 when DCT-4 phones are
flashed.

Cables
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-645. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.
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CA-101 Micro USB cable

The CA-101 is a USB-to-microUSB data cable that allows connections
between the PC and the phone.

CA-128RS RF tuning cable

Product-specific adapter cable for RF tuning.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-21 to a PC. It is included
in the FPS-21 sales package.
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CA-89DS Cable

Provides VBAT and Flashbus connections to mobile device
programming adapters.

DAU-9S MBUS cable

The MBUS cable DAU-9S has a modular connector and is used, for
example, between the PC's serial port and module jigs, flash adapters
or docking station adapters.

Note: Docking station adapters valid for DCT4 products.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.
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XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WCDMA2100/WLAN: 0.6+-0.1 dB

• WCDMA900: 0.3+-0.1 dB

  Service concepts

POS (Point of Sale) flash concept

Figure 2 POS flash concept

Type Description

Product specific tools

BL-5CT Battery

Other tools

FLS-5 POS flash dongle

PC with Phoenix service software
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Type Description

Cables

CA-101 Micro USB cable

Flash concept with FPS-21

Figure 3 Basic flash concept with FPS-21

Type Description

Product specific devices

FS-150 Flash adapter

Other devices

FPS-21 Flash prommer box

AC-35 Power supply

PK-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

CA-89DS Service cable
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Type Description

USB cable

CU-4 flash concept with FPS-21

Figure 4 CU-4 flash concept with FPS-21

Type Description

Product specific devices

FS-150 Flash adapter

Other devices

CU-4 Control unit

FPS-21 Flash prommer box

AC-35 Power supply

PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card (for DCT-4 generation mobile device programming)

PC with Phoenix service software

Cables
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Type Description

PCS-1 Power cable

CA-89DS Service cable

Standard USB cable

USB cable

Module jig service concept

Figure 5 Module jig service concept

Type Description

Phone specific devices

MJ-276 Module jig

Other devices

CU-4 Control unit

FPS-21 Flash prommer box

PK-1 SW security device

SX-4 Smart card

PC with VPOS and Phoenix service software

Measurement equipment

Cables

CA-89DS Service cable
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Type Description

PCS-1 DC power cable

XRS-6 RF cable

USB cable

GPIB control cable

BB/RF tuning concept with module jig

Type Description

Product specific tools

MJ-276 Module jig

Other tools

CU-4 Control unit

PK-1 SW security device

SX-4 Smart card

PC with Phoenix service software

Smart card reader

Cables

DAU-9S MBUS cable

PCS-1 Power cable
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Type Description

XRS-6 RF cable

USB cable

Bluetooth testing concept with SB-6

Figure 6 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices

FS-150 Flash adapter

Other devices

CU-4 Control unit

SS-62 Flash adapter base

PK-1 SW security device

SX-4 Smart card

SB-6 Bluetooth test and interface box

Smart card reader

PC with Phoenix service software

Cables

DAU-9S MBUS cable

PCS-1 DC power cable
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Type Description

USB cable

GPS testing concept with GPS RF coupler

Figure 7 RF testing concept with RF coupler

Type Description

Product specific devices

FS-150 Flash adapter

SA-131 GPS RF coupler

Other devices

CU-4 Control unit

SX-4 Smart card

JXS-1 RF shield box

PK-1 SW security device

SS-62 Flash adapter base

Smart card reader

Measurement equipment

PC with Phoenix service software

Cables
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Type Description

CA-128RS RF service cable (product-specific adapter cable)

PCS-1 Power cable

DAU-9S MBUS cable

XRS-6 RF cable

20dB attenuator

Interface cable

USB cable
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  Baseband self tests in Phoenix

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting.
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Troubleshooting flow
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  Power and charging troubleshooting

Dead or jammed device troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2
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Power key troubleshooting

Troubleshooting flow
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General voltage checking troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2
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General power checking
Check the following voltages:

Signal
Rename

Regulator Sleep Idle Nominal
voltage

Main user Notes

VIO Gazoo ON ON 1.8 Memory, I/Os,
display

VSIM Gazoo ON ON 1.8/3.0 SIM card

VAUX1 Gazoo ON ON 2.8 Display

VMEM Gazoo OFF OFF 2.9 MicroSD Disabled in
sleep

VDIGMIC Gazoo OFF OFF 1.8 Audio
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Charging troubleshooting

Troubleshooting flow
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USB charging troubleshooting

Troubleshooting flow
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Battery current measuring fault troubleshooting

Troubleshooting flow
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Clocking troubleshooting

Troubleshooting flow
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  Interface troubleshooting

Flash programming fault troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2

Figure 8 Flashing pic 1. Take single trig measurement for the rise of the BSI signal
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Figure 9 Flashing pic 2. Take single trig measurement for the rise of the BSI signal
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SIM card troubleshooting

Troubleshooting flow
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MicroSD card troubleshooting

Troubleshooting flow
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USB data interface troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2

  User interface troubleshooting

Keyboard and side keys troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys are stuck, so that the key does not react when a keydome or a side key is pressed. This
kind of failure is caused by mechanical reasons (dirt, rust, mechanical damage, etc.)
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• Malfunction of several keys at the same time. This happens when one or more rows or columns in the key
matrix are failing (shortcut or open connection).

If the failure mode is not clear, start with the Keyboard test in Phoenix.

In this phone the keyboard is connected to D2800 I/O pins.

Troubleshooting flow
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Keyboard LEDs troubleshooting

Troubleshooting flow

RM-645
BB Troubleshooting and Manual Tuning Guide

Page 3 – 26 COMPANY CONFIDENTIAL Issue 1
Copyright © 2010 Nokia. All rights reserved.



Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 7 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing.

• If a part of the image is missing, change the
display module.

• If the image is otherwise corrupted, follow the
display fault troubleshooting flowchart.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 8 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect counts R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be
interpreted as combined dot defect.
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Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Proceed to the display fault troubleshooting flowchart.

Use the Display Test tool in Phoenix to find the detailed fault mode.
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Display fault troubleshooting

Troubleshooting flow
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Display backlight troubleshooting

Troubleshooting flow

  Audio troubleshooting

Audio troubleshooting test instructions
External earpiece, internal earpiece and internal handsfree outputs can be measured either with a single-
ended or a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

The input signal for each loop test is single-ended.
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Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths are used in
the tests:

• AV mic to AV ear

• AV mic to HP ear

• Ext microphone in Int handsfree out

Note: The internal uplink microphones can be tested using the Phoenix self test "ST-DIGIMIC-TEST".
If the test result is PASS, the uplink microphones are electrically OK. For more thorough testing, see
section Internal microphone troubleshooting.

Each audio loop sets routing from the specified input to the specified output enables a quick in-out test. Loop
path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test are
presented in a table in the following section.

Phoenix audio loop tests and test results
The results presented in this table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speakers are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.

Loop test Input
terminal

Output
terminal

Path gain
[dB] (fixed)

Input voltage,
1 kHz sine
[mVp-p]

Single-ended
output

voltage [mVp-
p]

Output
DC level

[V]

AV mic to AV ear HS_MIC
and GND

HS_EAR_R and
GND

+21.3 100 584 0

HS_EAR_L and
GND

AV mic to HP ear HS_MIC
and GND

B2101 pad1
and GND

+18.2 100 407 1.5

B2101 pad2
and GND
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Loop test Input
terminal

Output
terminal

Path gain
[dB] (fixed)

Input voltage,
1 kHz sine
[mVp-p]

Single-ended
output

voltage [mVp-
p]

Output
DC level

[V]

Ext microphone
in Int handsfree
out

HS_MIC
and GND

B2102 pad1
and GND

+3.6 with
lowpass
filter

1000 758 with
lowpass filter

See the
Measurement
data graphics
below

NA

B2102 pad2
and GND

B2103 pad1
and GND

B2103 pad2
and GND

Measurement data

Figure 10 AV_IN – HP_OUT, single-ended loop measurement
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Figure 11 AV_IN – IHF_L_OUT, single-ended loop measurement without filter

Figure 12 AV_IN – AV_L _OUT, single-ended loop measurement

RM-645
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 – 33
Copyright © 2010 Nokia. All rights reserved.



Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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Internal handsfree (IHF) troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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Acoustics troubleshooting

Introduction to acoustics troubleshooting
Acoustics design ensures that the sound is detected correctly with a microphone and properly radiated to
the outside of the device by the speaker. The acoustics of the phone include three basic systems: earpiece,
stereo integrated handsfree (IHF) and digital microphone.

The sound reproduced from the earpiece readiates through a single hole on the front cover (A-cover). The
sound reproduced from the 2 IHF speakers radiates from the sound holes located on the bottom part of the
back cover. The microphone is located on the top side of the PWB, and the sound hole is in the keyboard near
the 0-key.

For a correct functionality of the phone, all sound holes must be always open. When the phone is used, care
must be taken not to close any of those holes with a hand or fingers. The phone should be dry and clean,
and no objects must be located in such a way that they close any of the holes.
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Earpiece troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow
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Microphone troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow

  GPS troubleshooting

GPS antenna
The GPS antenna is located on the back side of the B-cover (left-hand side, upper corner).

RM-645
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 – 43
Copyright © 2010 Nokia. All rights reserved.



Figure 13 GPS antenna
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GPS layout and basic test points

Figure 14 GPS layout and basic test points

VBat, ASIC internal LDO voltages, clocks and one test pad J6200 (activity on this pad indicates the GPS is
operating) are available as shown in figure "GPS layout and basic test points" above.

GPS settings for Phoenix

GPS control

Context
Use the following to test GPS using Phoenix.

Steps
1. Start Phoenix service software.

2. From the File menu, select Scan Product and check that the correct product version is displayed.
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3. From the Testing menu, select GPS Control. This opens up GPS Control dialogue box, as shown in the
figure below, and enables the GPS.

Select Idle to confirm the GPS is enabled and is in idle mode; at this point all clocks should be present,
GPS_En_Reset should be high (1.8V), and Vdd_Dig (1.1V), Vcc_TCXO (2.5V) & Vcc_PLL/VCO (1.35V) should be
present. Turning Receiver Action On  will turn on all the RF sections of the ASIC and so all LDOs will be
on.

Note: These checks are part of  GPS basic checks troubleshooting (page 3–52 ) .

Figure 15 GPS Control dialog box
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Figure 16 Simple Tests – Oscillator Test & Receiver Self Test

Oscillator test

Context
The 16.368 MHz GPS Clk is compared against the CE Ref Clk and the output is the GPS Clk offset.

Steps
1. Start Phoenix service software.

2. From the Testing menu, select GPS Control. This opens up GPS Control dialogue box and enables the GPS.

In the Rx Control window, go to the Simple Tests section, select Oscillator Test and click Start. The Offset
result will be returned and should be within the limits of +- 84Hz.
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Figure 17 Simple Tests – Oscillator Test

Receiver self test

Context
Receiver self test can be used to check the correct functionality of the receiver core. For the test, GPS software
configures internal test source to generate synthetic GPS-like data, processing it in the baseband and writing
the results into the channel processor memory. The test compares the data in the channel memory against
the expected value and reports a PASS/FAIL status.

Steps
1. Start Phoenix service software.

2. From the Testing menu, select GPS Control. This opens up GPS Control dialogue box and enables the GPS.

In the Rx Control window, go to the Simple Tests section, select Receiver Self Test and click Start. The
test returns a PASS/FAIL result.

Note: The Oscillator Test should not be run after the Receiver Self Test. This sequence of tests may
cause the Oscillator test to prolong and result in Phoenix timing out. If you are carrying out both of
these tests, run the Oscillator Test first, after which you can run the Receiver Self Test.

RM-645
BB Troubleshooting and Manual Tuning Guide

Page 3 – 48 COMPANY CONFIDENTIAL Issue 1
Copyright © 2010 Nokia. All rights reserved.



Figure 18 Simple Tests – Receiver Self Test

CW Test

Context
This test reports the SNR of a CW signal input to the GPS antenna port.

Steps
1. Start Phoenix service software.

2. From the Testing menu, select GPS Control. This opens up GPS Control dialogue box and enables the GPS.

In the CW Test window, ensure the input settings are as shown in the figure below. Inject 1575.52 MHz
tone at the GPS antenna test connector at a level of -110dBm and click Start.

For Pin = -110dBm and negligible other losses, the expected result ranges are:

• Galvanic 29.8dB to 38.1dB

• Radiated 25.8dB to 38.1dB
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Figure 19 CW Test window

Quick Test window
Because the Quick Test runs the Receiver Self Test before the Oscillator Test, it may cause a timeout on the
Oscillator Test. It does not necessarily mean that Oscillator Test has failed, but carrying out the  Oscillator
Test (page 3–47 ) ,  Receiver Self Test (page 3–48 )  and  CW Test (page 3–49 )  individually will give more
valid results.
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Figure 20 GPS Quick Test window for GPS troubleshooting

GPS failure troubleshooting

Context
GPS troubleshooting is broken down into two parts: General GPS failure and GPS basic checks. The GPS failure
troubleshooting flow can be followed and, where applicable, will feed into the basic checks troubleshooting
flow.
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Troubleshooting flow
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GPS basic checks troubleshooting

Troubleshooting flow

  Bluetooth and FM radio troubleshooting

Bluetooth and FM radio introduction
The Bluetooth and FM radio are combined in the same ASIC, so both features are checked when
troubleshooting. The following problems can occur with the Bluetooth and FM radio hardware:
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Symptom Problem Repair solution

Unable to switch on
Bluetooth on phone
user interface.

Open circuit solder joints or
component failure of BTH/
FM ASIC/module BB ASICs or
SMD components.

Replacement of the engine.

Able to send data file
to another Bluetooth
device, but unable to
hear audio through
functional Bluetooth
headset.

Open circuit solder joints or
component failure of BTH/
FM ASIC/module BB ASICs
(PCM interface).

Replacement of the engine.

Able to turn on
Bluetooth on phone
user interface, but
unable to detect other
Bluetooth devices.

Open circuit solder joints or
detached component in
Bluetooth antenna circuit
or Pogo Pin not making
contact with C-cover.

Repair of the Bluetooth antenna circuit
or replacement of the BT/GPS antenna (C-
cover).

Able to turn on FM
radio and Bluetooth
on phone user
interface, but unable
to detect local FM radio
stations with FM
headset inserted.

Open circuit solder joints or
detached component in FM
antenna circuit.

Repair of the FM antenna circuit or
replacement of the AV connector.

Able to perform scans
to detect local FM radio
stations with
functional FM headset
inserted, but unable to
hear FM audio through
headset.

Open circuit solder joints or
detached component in FM
audio path between
Bluetooth/FM ASIC and
headset.

Repair or replacement of the FM audio AV
connector and circuits.

Bluetooth and FM radio component placement
The figure below shows the key component placement for BTHFMRDS2.2D in RM-645.

RM-645
BB Troubleshooting and Manual Tuning Guide

Page 3 – 54 COMPANY CONFIDENTIAL Issue 1
Copyright © 2010 Nokia. All rights reserved.



Figure 21 Key component placement for BTHFMRDS2.2D

The Bluetooth antenna element and the antenna pogo pin are attached to the B-cover, and the Bluetooth RF
signal is routed through X front-end module.

Figure 22 BT antenna

The FM radio audio signal is routed to the headset connector through the BB ASIC shared by the phone audio
functions.

Bluetooth and FM Radio Self Tests

Context
A flash adapter (or phone data cable) connected to a PC with Phoenix service software is required.

Steps
1. Place the phone in the flash adapter.

2. Start Phoenix service software.

3. Choose File → Scan Product.

4. From the Mode drop-down menu, set to Local.

5. Choose Testing → Self Tests.

RM-645
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 – 55
Copyright © 2010 Nokia. All rights reserved.



6. In the Self Tests window check the following Bluetooth and FM Radio tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST

• ST_RADIO_TEST

7. To run the test, click Start

Bluetooth BER test
JBT-9 or SB-6 Bluetooth test box (BT box) is required to perform a BER test. If a BT box is not available,
Bluetooth functionality can be checked by transferring a file to another Bluetooth phone.
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Bluetooth and FM radio module troubleshooting

Troubleshooting flow
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  Baseband manual tuning guide

Certificate restoring for BB5 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-20 or FPS-21.

Note: USB flashing does not work for a dead BB5 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2008.34/38 or newer.

• The latest phone model specific Phoenix data package.

• Care dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

• Activated FPS-20 flash prommer OR FPS-21 flash prommer

• Flash update package 08.30.012 or newer for FPS-20 or FPS-21 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• Service cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-20 or FPS-21.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from  File → Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to  Flashing → SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose  File → Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose  File → Scan Product .

ii Choose  Tools → Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose  File → Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.

RM-645
BB Troubleshooting and Manual Tuning Guide

Page 3 – 62 COMPANY CONFIDENTIAL Issue 1
Copyright © 2010 Nokia. All rights reserved.



Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose  File →  Scan Product.

4. Choose  Tuning → Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 9 Calibration value limits

Parameter Min. Max.

ADC Offset -30 +40

ADC Gain 12000 14000

BSI Gain 1100 1350

VBAT Offset 2635 2755

VBAT Gain 14900 15900

VCHAR Gain N/A N/A

IBAT (ICal) Gain 9000 11000

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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  General RF troubleshooting

Introduction to RF troubleshooting

Most RF semiconductors are static discharge sensitive
ESD protection must be applied during repair (ground straps and ESD soldering irons).

Pre-baking
These parts are moisture sensitive and must be pre-baked prior to soldering:

• VAPAUS RFIC (N7500)

• TX FEM (N7520)

• WCDMA PA (N7540)

• Aura DC/DC converter (N7560)

Discrete components
In addition to the key components, there are a number of discrete components (resistors, inductors and
capacitors) for which troubleshooting is done mainly by visual inspection.

Capacitors: check for short circuits.

Resistors: check value with an ohm meter.

Note: In-circuit measurements should be evaluated carefully.

Measuring equipment
All measurements should be done using:

• Module jig MJ-276

• Flash adapter FS-150

• Control unit CU-4/Interface adapter SS-46

• An oscilloscope for low frequency and DC measurements. Recommended probe: 10:1, 10MOhm/8pF.

• A radio communication tester including RF generator and spectrum analyser, for example Rohde & Schwarz
CMU200. (Alternatively a spectrum analyser and a RF generator can be used. However, some tests in this
guide are not possible to perform if this solution is chosen).

Note: A mobile phone WCDMA transmitter should never be tested with full TX power (only if it is
possible to perform the measurement in a good RF-shielded room). Even low power WCDMA
transmitters may disturb nearby WCDMA networks and cause problems to 3G cellular phone
communication in a wide area.

Note: All measurements with an RF coupler should be performed in an RF-shielded environment
because nearby base stations can disturb sensitive receiver measurements. If there is no possibility
to use RF shielded environment, testing at frequencies of nearby base stations should be avoided.

Level of repair
The scope of this guideline is to verify functionality of the cellular RF block.
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RF key components

Figure 23 RF key components
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  Auto tuning

Introduction to auto tuning
This phone can be tuned automatically.

Auto tune is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
Hardware requirements for auto tuning:

• PC (Windows 2000/XP) with GPIB card

• PK-1 service dongle

• Power supply

• Product specific module jig

• Cables: RF cable XRS-6, USB cable, GBIP cable and MBUS cable DAU-9S

• Signal analyser (TX), signal generator (RX) and RF-splitter or one device including all.

Figure 24 Auto tuning concept with CMU200

Auto tuning procedure

Prerequisites
Install the phone-specific data package, e.g. Nokia_firmware_RM_645_Europe_0.11.10_v1.00.exe.

The data package defines the phone-specific settings and it supports the non-signaling tests (RF FINUI Tests).

Note: The External Phoenix version must be 2008.34.10.36039 or newer.

Steps
1. Make sure the phone (in the jig) is connected to the equipment. Else, some menus will not be shown in

Phoenix.

2. Go to loss settings by selecting  Tuning (Alt_U) → SET LOSS  from the menu.

3. Set the loss between CMU200 and the phone. (Total loss = cable + jig)

4. Go to auto tuning by selecting  Tuning (Alt_U) → Auto-tune (Alt_A)  from the menu.

5. Start auto tuning by clicking the Tune button.
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  Self test troubleshooting

Phoenix self test troubleshooting

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting in
chapter 3, BB Troubleshooting and Manual Tuning Guide.

Note: Self tests are recommended to be made when phone is in jig and a 50Ω load connected to
the RF connector. Otherwise power tests may fail depending on antenna load
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Troubleshooting flow
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  Receiver troubleshooting

Introduction to receiver (RX) troubleshooting
RX can be tested by making a phone call or in local mode. For the local mode testing, use Phoenix service
software.

The main RX troubleshooting measurement is RSSI reading. This test measures the signal strength of the
received signal. For GSM RSSI measurements, see section  GSM RX chain activation for manual measurements/
GSM RSSI measurement (page 4–10 ) . For a similar test in WCDMA mode, see section  WCDMA RSSI
measurement (page 4–13 ) .

GSM RX chain activation for manual measurements/GSM RSSI measurement

Prerequisites
Make the following settings in signal generator and Phoenix service software:

Setting GSM850 GSM900 GSM1800 GSM1900

Phoenix Channel 190 37 700 661

Signal generator
to antenna
connector

881.66771MHz
(67.71kHz offset)
at -60dBm

942.46771MHz
(67.71kHz offset)
at -60dBm

1842.86771MHz
(67.71kHz offset)
at -60dBm

1960.06771MHz
(67.71kHz offset)
at -60dBm

Steps
1. Set the phone to local mode.

2. Activate RSSI reading in Phoenix by selecting  Testing → GSM → RSSI reading .

Figure 25 Phoenix RSSI Reading window

Results
The reading should reflect the level of the signal generator (minus losses) ±5dB.

When varying the level in the range -30 to -102dBm the reading should then follow within ±5dB.
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GSM receiver troubleshooting flowchart

Troubleshooting flow
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WCDMA RX chain activation for manual measurement

Steps
1. In Phoenix, select  Testing → WCDMA → Rx Control . The Phoenix Rx Control window opens.

Figure 26 Phoenix Rx Control window with sample settings (WCDMA band I)

2. Make settings for the band to be tested according to the following table:

Band to be tested Phoenix Channel Signal generator to antenna
connector

WCDMA I 10700 2141.0MHz

WCDMA VIII 3013 943.6MHz

3. Make the following general settings (the same values for all bands):

Setting Value

AGC Mode Algorithm

AFC Algorithm OFF

AFC DAC 1024

4. Click Start to activate the settings.

If the settings are changed later on (for example, change of channel) you have to click Stop and Start
again.

Note: Clicking Stop also disables TX control if it was active.
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WCDMA RSSI measurement

Prerequisites
WCDMA RX must be activated before RSSI can be measured. For instructions, please refer to  WCDMA RX chain
activation for manual measurement (page 4–12 ) .

Connect signal generator to RF connector and use appropriate frequency for each channel.

Steps
1. In Phoenix select  Testing → WCDMA → RX Power measurement . The Rx Power Measurement window

opens.

Figure 27 Phoenix Rx Power Measurement window

2. In the RX Power measurement window, select:

• Mode: RSSI

• Continuous mode

3. Click Start to perform the measurement.

Note: WCDMA RSSI measurement is accurate only with WCDMA modulated signal.
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WCDMA receiver troubleshooting flowchart

Troubleshooting flow
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  Transmitter troubleshooting

Introduction to transmitter (TX) troubleshooting
Please note the following before performing transmitter tests:

• TX troubleshooting requires TX operation.

• Do not transmit on frequencies that are in use!

• The transmitter can be controlled in local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is “RF Control”; in WCDMA transmitter testing
the best tool is “TX Control”.

• Remember that re-tuning is not a fix! Phones are tuned correctly in production.

Note: Never activate the GSM or WCDMA transmitter without a proper antenna load. Always connect
a 50Ω load to the RF connector (antenna, RF-measurement equipment or at least a 2W dummy load);
otherwise the GSM or WCDMA Power amplifier (PA) may be damaged.

GSM transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select  Testing → GSM → Rf Controls . The RF Controls window opens.

Figure 28 Phoenix RF Controls window

3. Make the following settings:
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Setting Value

Active Unit Tx

Rx/Tx Channel 37

Band GSM 900

AFC -28

Operation Mode Burst

Edge Off

Tx Data Type Random

Tx PA Mode High

Tx Power Level 5

4. Check the basic TX parameters, using a communication analyser (e.g. CMU200).

• Power

• Phase error

• Modulation

• Switching spectrum
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Figure 29 Typical readings

5. Change the power level in RF controls window and make sure the power reading follows accordingly.
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Next actions
You can troubleshoot the GSM transmitter for each GSM band separately, one band at a time. If you want to
troubleshoot GSM850, GSM1800 or GSM1900, change the band in the RF controls window and set the
communication analyser accordingly.
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GSM transmitter troubleshooting flowchart

Troubleshooting flow
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WCDMA transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select  Testing → WCDMA → Tx control . The Tx Control window opens.

Figure 30 Phoenix WCDMA Tx control window

3. Make settings for the band to be tested, according to the following table:

Band Channel

WCDMA I 9750

WCDMA VIII 2788

4. Make the following general settings (the same values for all bands). Note that Max power limit is not
checked by default.
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Setting Value

DPDCH enabled Checked

Max power limit Checked

Start Rx Checked

Start level 24

Step size 0

Step count 0

Sequency 0

Step duration 2550

Code class LONG

Code 16

DPDCH code 0

Weight 15

Code class 2

DPCCH code 0

Weight 8

Code class 2

Note: Use the Start level option to set the TX power level.

5. Click Send to enable the settings and activate TX.

If settings are changed (eg. new channel selected), you have to click RF Stop and Send again.

6. Check the basic TX parameters using a communication analyser (e.g. CMU200).
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Figure 31 Typical readings
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WCDMA transmitter troubleshooting flowchart

Troubleshooting flow
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  Antenna troubleshooting

Visual check for antenna contacts
In the main antenna there is one feed and one GND contact. Check that GND and feed pads take proper contact
to the pogo pin on the main PWB and the radiator flex.

Figure 32 Antenna contacts

RM-645
RF Troubleshooting

Page 4 – 24 COMPANY CONFIDENTIAL Issue 1
Copyright © 2010 Nokia. All rights reserved.



5  — Camera Module
Troubleshooting

Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 5 – 1
Copyright © 2010 Nokia. All rights reserved.



RM-645
Camera Module Troubleshooting

(This page left intentionally blank.)

Page 5 – 2 COMPANY CONFIDENTIAL Issue 1
Copyright © 2010 Nokia. All rights reserved.



Table of Contents
Main (back) camera troubleshooting .................................................................................................................. 5–5

Taking and evaluating test pictures with main camera .............................................................................. 5–5
Main camera troubleshooting......................................................................................................................... 5–6
Main camera baseband troubleshooting....................................................................................................... 5–7
Main camera no recognizable viewfinder image troubleshooting............................................................. 5–9
Main camera bad image quality troubleshooting ........................................................................................ 5–9
Camera flash troubleshooting .....................................................................................................................  5–10

Secondary (front) camera troubleshooting .....................................................................................................  5–12
Evaluating video call picture quality from secondary camera..................................................................  5–12
Secondary camera hardware troubleshooting ..........................................................................................  5–12
Secondary camera bad image quality troubleshooting............................................................................  5–14

List of Figures
Figure 33 Camera socket pin order...................................................................................................................... 5–8

RM-645
Camera Module Troubleshooting

Issue 1 COMPANY CONFIDENTIAL Page 5 – 3
Copyright © 2010 Nokia. All rights reserved.



RM-645
Camera Module Troubleshooting

(This page left intentionally blank.)

Page 5 – 4 COMPANY CONFIDENTIAL Issue 1
Copyright © 2010 Nokia. All rights reserved.



  Main (back) camera troubleshooting

Taking and evaluating test pictures with main camera
When taking a test picture, remember the following:

• Avoid bright fluorescent light, 50/60Hz electrical network or high artificial illumination levels

• If the phone is hot, let it rest for a while before taking the picture

• Make sure the optical system is clean

• Use the highest possible resolution

• Make sure the light is sufficient (bright office lighting)

• Do not take the picture towards a light source

• Hold the phone as still as possible when taking the picture

When evaluating a test picture, remember the following:

• The centre of the picture is sharper than the edges

• The image may be blurred, though it does not show in the viewfinder

• Analyse the picture from your PC monitor, full colour setting is recommended

• If possible, compare with a picture of the same motive taken with a similar Nokia device
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Main camera troubleshooting

Troubleshooting flow
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Main camera baseband troubleshooting

Troubleshooting flow
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Camera socket pin order

Figure 33 Camera socket pin order
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Main camera no recognizable viewfinder image troubleshooting

Troubleshooting flow
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Main camera bad image quality troubleshooting

Troubleshooting flow
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Camera flash troubleshooting

Context
Note: Before checking flash functionality, make sure that the main camera is working ok.

Troubleshooting flow
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  Secondary (front) camera troubleshooting

Evaluating video call picture quality from secondary camera
When testing the picture quality of a video call, remember the following:

• Avoid bright fluorescent light, 50/60Hz electrical network or high artificial illumination levels

• Make sure the optical system is clean

• Make sure the light is sufficient (bright office lighting)

• Do not take the picture towards light source

• Hold the phone as still as possible when evaluating the video call image quality

• Distance should be approximately 40 cm

When evaluating the picture quality of a video call, remember the following:

Note: Always use the "troubled" phone when evaluating a picture in a video call. Do not evaluate
the picture on the receiving phone.

• The centre of the picture is sharper than the edges

• If possible, compare with the picture on another Nokia device in a video call, and of the same motive

Secondary camera hardware troubleshooting

If the front camera is NOT underfilled
Note: Phone must be in a video call for the secondary camera to be active.

Note: Always use the "troubled" phone when evaluating a picture in a video call. Do not evaluate
the picture on the receiving phone.
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If the front camera is underfilled

Secondary camera bad image quality troubleshooting

Context
Note: Phone must be in a video call for the front camera to be active.

Note: Always use the "troubled" phone when evaluating a picture in a video call. Do not evaluate
the picture on the receiving phone.
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Troubleshooting flow
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  Introduction

Phone description
RAPU is the main digital baseband ASIC in the phone. It contains functionality for both WCDMA and GSM EDGE.

GAZOO (N2200) is the main audio and energy management controller for the phone.

Key components

Function Description Item ref

Main PWB 3FT

UI flex PWB 3FU

Baseband ASIC EM ASIC GAZOO N2200

RF ASIC VAPAUS N7500

Processor RAPU D2800

GSM PA Front end module (FEM), quad band N7520

WCDMA PA WCDMA power amplifier module N7540

Oscillators VCTCXO

Balun GSM

G7500

T7520

Memory Combo 1G DDR + 2G M3 (stacked with RAPU) D3000

Back-up battery RTC back-up battery 311 G2200

Bluetooth BTFMRDS2.2D module N6000

FM radio BTFMRDS2.2D module N6000

A-GPS A-GPS module N6200

USB USB transceiver D3300

Battery BL-5CT

Battery connector Tabby blade interface X2070

MicroSD connector X3200

Micro USB connector X3300

BTB connector Board-to-board connector X4400

RF connectors X6200

X7501

SIM connector X2700
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Key component placement
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System module block diagram
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Board and module connections

  Energy management

Battery and charging

BL-5CT battery
The phone is powered by a 3-pole BL-5CT 1050 mAh battery. The three poles are named VBAT, BSI and GND
where the BSI line is used to recognize the battery capacity. This is done by means of an internal battery pull
down resistor.

Figure 34 Battery pin order
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The battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line.
This is located on the main PWB, at the place where the phone temperature is closest to the battery
temperature.

Battery connector
The battery connector is a blade connector. It has three blades;

• BSI (Battery size indicator)

• GND (Ground)

• VBAT (Battery voltage)

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.

Charging
The phone can be charged through the dedicated charger interface or through the micro USB interface.

Charging is controlled by energy management, and external components are needed to protect the baseband
module against EMC, reverse polarity and transient frequency deviation.

Charging a dead battery
It may take up to several minutes before the phone indicates that it is charging if the battery is dead.

Normal and extreme voltages
Energy management is mainly carried out in the EM ASIC (N2200). that contains a number of regulators. In
addition there are also some external regulators.

In the table below normal and extreme voltages are shown when a BL-5CT battery is used.

Table 10 Nominal voltages

Voltage Voltage [V] Condition

General Conditions

Nominal voltage 3.700

Lower extreme voltage 3.5

Higher extreme voltage

4.2(fast charging)

HW Shutdown Voltages

Vmstr+ 2.1 ± 0.1 Off to on

Vmstr- 1.9 ± 0.1 On to off

SW Shutdown Voltages

Sw shutdown 3.1 In call

Sw shutdown 3.2 In idle

Min Operating Voltage

Vcoff+ 2.9 ± 0.1 Off to on

Vcoff- 2.7 ± 0.1 On to off
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Power key and system power-up
When the battery is placed in the phone, the power key circuits are energized. When the power key is pressed,
the system boots up (if an adequate battery voltage is present).

Power down can be initiated by pressing the power key again and the system is powered down with the aid
of SW. The power key is connected to EM ASIC (N2200) via the PWRONX signal.

Modes of operation

Mode Description

NO_SUPPLY (Dead) mode means that the main battery is not present or its voltage is too low (below
EM ASIC master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over EM ASIC master
reset threshold. All regulators are disabled, PurX is on low state, the RTC is on and the
oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm), but the
RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. RESET mode uses 32kHz clock to count
the RESET mode delay (typically 16ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.

Clocking scheme
In BB5.44, two main clocks are provided to the system: 38.4MHz RF clock produced by VCTCXO in the RF section
and 32.768kHz sleep clock produced by EM ASIC N2200 with an external crystal.

32 k Sleep Clock is always powered on after startup. Sleep clock is used by RAPU for low-power operation.

SMPS Clk is 3.2MHz clock line from RAPU to EM ASIC N2200. In deep sleep mode, when VCTCXO is off, this signal
is set to '0'-state.

CLK600. The clock source is an internal RC oscillator in EM ASIC N2200 (during the power-up sequence) or
RAPU SMPS Clk.

Bluetooth uses a buffered and filtered 38.4MHz system clock from VCTCXO G7500.
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Power distibution

Figure 35 Power distribution diagram
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  SIM interface
The phone has a SIM (Subscriber Identification Module) interface including a SIM connector. The connector
is only accessible when the battery is removed.

The SIM interface consists of an internal interface between RAPU and EM ASIC (N2200), and an external
interface between EM ASIC and SIM contacts.

Figure 36 SIM interface

The EM ASIC handles the detection of the SIM card. The detection method is based on the BSI line. Because of
the location of the SIM connector, removing the battery causes a quick power down of the SIM interface.

The SIM interface supports both 1.8V and 3.0V SIM cards. The SIM interface voltage is first 1.8 V when the SIM
card is inserted, and if the card does not respond to the ATR (Answer to Request), a 3V interface voltage is
used.

  MicroSD card interface
The microSD card interface has one internal interface between RAPU and EM ASIC and one external interface
between EM ASIC and the microSD card. The microSD card connector is mounted on the main PWB.

The µSD removal detection switch is inside the card sockect.

Figure 37 MicroSD card interface
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  USB

USB interface
The phone has an interface for USB (Universal Serial Bus). USB is a differential serial bus that provides a wired
connectivity between a PC and peripheral devices, as in this case a mobile phone.

Figure 38 USB interface

The phone supports USB 2.0 with High-Speed (480 Mbps).

Hot swap is supported, which means that USB devices may be plugged in and out at any time.

MicroUSB connector
This phone is provided with a specific connector for microUSB.

Figure 39 MicroUSB connector
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  User interface

Display interface
The following block diagram illustrates the display interface.

Display backlight is provided directly by EM ASIC.

Figure 40 Display interface

Keyboard interface
The following block diagram shows the keyboard interface. The keyboard interface is implemented with
RAPU’s GENIOs. Keyboard GENIOs are protected from ESD with 10-channel ASIPs Z4404 and Z4405. In addition
there are two capacitors C4401 and C4402 added to PWB for improving the immunity to the device's own
low band TX.

RM-645 keyboard supports 3 keys multikeypress functionality.

The LEDs at the UI mechanic assembly for main keyboard are controlled by EM ASIC.
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Figure 41 Keyboard interface

  Camera interface
The main camera is able to take images over larger depth of field (from 30 cm to infinity) than normal fixed
focus camera. When compared to autofocus (AF) cameras, it is to be noted that there are no moving parts
inside this camera.

In this device the main camera, the secondary camera and the camera flash driver are connected directly to
RAPU and controlled by the I2C bus, port 0. Both cameras are supplied by separate voltage regulators enabled
by the camera software (GENIOs).

Control signals to and from the camera flash driver are connected directly to RAPU (GENIOs).
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Figure 42 Camera interface

  Audio interface
The following block diagram illustrates the audio interface of the phone:
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Figure 43 Audio interface

The digital microphone is connected directly to RAPU.

Stereo output is provided by a separate stereo audio amplifier that is connected to EM ASIC. The output from
the stereo audio amplifier is fed to the AV connector.

The earpiece is driven directly by a built-in amplifier included in EM ASIC.

The stereo IHF speakers are driven directly by a built-in stereo amplifier included in EM ASIC.

The vibra is driven directly by a built-in amplifier included in EM ASIC.

  Bluetooth interface
Bluetooth provides a fully digital link for communication between a master unit (the phone) and one or more
slave units (e.g. a wireless headset). Data and control interface for a low power RF module is provided by the
BTHFM module.

Bluetooth is physically integrated with FM radio in the BTHFM module ASIC, but from a functional point of
view they have nothing in common
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Figure 44 Bluetooth interface

The BTHFM module is powered by VBAT and the regulated voltage VIO. For audio applications the Bluetooth
has a PCM data bus. In addition an UART (universal asynchronous receiver/transmitter) is used for data
communication and controls.

  GPS interface
The device includes an inbuilt GPS receiver and it works as a stand-alone positioning device.

The GPS system is connected to RAPU ASIC.
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Figure 45 GPS interface

  FM radio interface
The FM radio system is controlled by RAPU via the I2C bus. EM ASIC delivers the needed voltages and the clock
reference (32.768kHz SleepClk). EM ASIC also processes the analog audio.

The FM receiver fully supports reception over US/European (87.5MHz to 108MHz) FM band. The FM receiver
comprises an RF receiver with fully integrated VCO, a stereo FM demodulator and a RDS demodulator.

A headset accessory is used as an external antenna. The headset is connected to the AV connector.

FM radio is physically integrated with Bluetooth in the BTHFM module ASIC, but from a functional point of
view FM radio and Bluetooth have nothing in common.

Figure 46 FM radio interface
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  RF description

Receiver (RX)
An analogue signal is received by the phone's antenna. The signal is converted to a digital signal and then
transferred further to the baseband (e.g. to the earpiece).

The receiver functions are implemented in the RF ASIC.

Signals with different frequencies take different paths, therefore being handled by different components.
The principle of GSM and WCDMA is the same.

Transmitter (TX)
The digital baseband signal (e.g. from the microphone) is converted to an analogue signal which is then
amplified and transmitted from the antenna. The frequency of this signal can be tuned to match the bandwith
of the system in use (e.g. GSM900).

The transmitter functions are implemented in the RF ASIC.

Even though the GSM and WCDMA signals are sent via different components, the principle of the transmission
is the same.
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  Frequency mappings

GSM850 frequencies
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EGSM900 frequencies
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GSM1800 frequencies
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GSM1900 frequencies
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WCDMA 2100 Rx frequencies
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WCDMA 2100 Tx frequencies
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WCDMA VIII (900) frequencies

Uplink CH (TX) Freq (MHz) VCO (MHz) Downlink CH (RX) Freq (MHz) VCO (MHz)

2712 882,4 3529,6 2937 927,4 3709,6

2713 882,6 3530,4 2938 927,6 3710,4

2714 882,8 3531,2 2939 927,8 3711,2

2715 883 3532 2940 928 3712

2716 883,2 3532,8 2941 928,2 3712,8

2717 883,4 3533,6 2942 928,4 3713,6

2718 883,6 3534,4 2943 928,6 3714,4

2719 883,8 3535,2 2944 928,8 3715,2

2720 884 3536 2945 929 3716

2721 884,2 3536,8 2946 929,2 3716,8

2722 884,4 3537,6 2947 929,4 3717,6

2723 884,6 3538,4 2948 929,6 3718,4

2724 884,8 3539,2 2949 929,8 3719,2

2725 885 3540 2950 930 3720

2726 885,2 3540,8 2951 930,2 3720,8

2727 885,4 3541,6 2952 930,4 3721,6

2728 885,6 3542,4 2953 930,6 3722,4

2729 885,8 3543,2 2954 930,8 3723,2

2730 886 3544 2955 931 3724

2731 886,2 3544,8 2956 931,2 3724,8

2732 886,4 3545,6 2957 931,4 3725,6

2733 886,6 3546,4 2958 931,6 3726,4

2734 886,8 3547,2 2959 931,8 3727,2

2735 887 3548 2960 932 3728

2736 887,2 3548,8 2961 932,2 3728,8

2737 887,4 3549,6 2962 932,4 3729,6

2738 887,6 3550,4 2963 932,6 3730,4

2739 887,8 3551,2 2964 932,8 3731,2

2740 888 3552 2965 933 3732

2741 888,2 3552,8 2966 933,2 3732,8

2742 888,4 3553,6 2967 933,4 3733,6

2743 888,6 3554,4 2968 933,6 3734,4

2744 888,8 3555,2 2969 933,8 3735,2
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Uplink CH (TX) Freq (MHz) VCO (MHz) Downlink CH (RX) Freq (MHz) VCO (MHz)

2745 889 3556 2970 934 3736

2746 889,2 3556,8 2971 934,2 3736,8

2747 889,4 3557,6 2972 934,4 3737,6

2748 889,6 3558,4 2973 934,6 3738,4

2749 889,8 3559,2 2974 934,8 3739,2

2750 890 3560 2975 935 3740

2751 890,2 3560,8 2976 935,2 3740,8

2752 890,4 3561,6 2977 935,4 3741,6

2753 890,6 3562,4 2978 935,6 3742,4

2754 890,8 3563,2 2979 935,8 3743,2

2755 891 3564 2980 936 3744

2756 891,2 3564,8 2981 936,2 3744,8

2757 891,4 3565,6 2982 936,4 3745,6

2758 891,6 3566,4 2983 936,6 3746,4

2759 891,8 3567,2 2984 936,8 3747,2

2760 892 3568 2985 937 3748

2761 892,2 3568,8 2986 937,2 3748,8

2762 892,4 3569,6 2987 937,4 3749,6

2763 892,6 3570,4 2988 937,6 3750,4

2764 892,8 3571,2 2989 937,8 3751,2

2765 893 3572 2990 938 3752

2766 893,2 3572,8 2991 938,2 3752,8

2767 893,4 3573,6 2992 938,4 3753,6

2768 893,6 3574,4 2993 938,6 3754,4

2769 893,8 3575,2 2994 938,8 3755,2

2770 894 3576 2995 939 3756

2771 894,2 3576,8 2996 939,2 3756,8

2772 894,4 3577,6 2997 939,4 3757,6

2773 894,6 3578,4 2998 939,6 3758,4

2774 894,8 3579,2 2999 939,8 3759,2

2775 895 3580 3000 940 3760

2776 895,2 3580,8 3001 940,2 3760,8

2777 895,4 3581,6 3002 940,4 3761,6

2778 895,6 3582,4 3003 940,6 3762,4

2779 895,8 3583,2 3004 940,8 3763,2
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Uplink CH (TX) Freq (MHz) VCO (MHz) Downlink CH (RX) Freq (MHz) VCO (MHz)

2780 896 3584 3005 941 3764

2781 896,2 3584,8 3006 941,2 3764,8

2782 896,4 3585,6 3007 941,4 3765,6

2783 896,6 3586,4 3008 941,6 3766,4

2784 896,8 3587,2 3009 941,8 3767,2

2785 897 3588 3010 942 3768

2786 897,2 3588,8 3011 942,2 3768,8

2787 897,4 3589,6 3012 942,4 3769,6

2788 897,6 3590,4 3013 942,6 3770,4

2789 897,8 3591,2 3014 942,8 3771,2

2790 898 3592 3015 943 3772

2791 898,2 3592,8 3016 943,2 3772,8

2792 898,4 3593,6 3017 943,4 3773,6

2793 898,6 3594,4 3018 943,6 3774,4

2794 898,8 3595,2 3019 943,8 3775,2

2795 899 3596 3020 944 3776

2796 899,2 3596,8 3021 944,2 3776,8

2797 899,4 3597,6 3022 944,4 3777,6

2798 899,6 3598,4 3023 944,6 3778,4

2799 899,8 3599,2 3024 944,8 3779,2

2800 900 3600 3025 945 3780

2801 900,2 3600,8 3026 945,2 3780,8

2802 900,4 3601,6 3027 945,4 3781,6

2803 900,6 3602,4 3028 945,6 3782,4

2804 900,8 3603,2 3029 945,8 3783,2

2805 901 3604 3030 946 3784

2806 901,2 3604,8 3031 946,2 3784,8

2807 901,4 3605,6 3032 946,4 3785,6

2808 901,6 3606,4 3033 946,6 3786,4

2809 901,8 3607,2 3034 946,8 3787,2

2810 902 3608 3035 947 3788

2811 902,2 3608,8 3036 947,2 3788,8

2812 902,4 3609,6 3037 947,4 3789,6

2813 902,6 3610,4 3038 947,6 3790,4

2814 902,8 3611,2 3039 947,8 3791,2
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Uplink CH (TX) Freq (MHz) VCO (MHz) Downlink CH (RX) Freq (MHz) VCO (MHz)

2815 903 3612 3040 948 3792

2816 903,2 3612,8 3041 948,2 3792,8

2817 903,4 3613,6 3042 948,4 3793,6

2818 903,6 3614,4 3043 948,6 3794,4

2819 903,8 3615,2 3044 948,8 3795,2

2820 904 3616 3045 949 3796

2821 904,2 3616,8 3046 949,2 3796,8

2822 904,4 3617,6 3047 949,4 3797,6

2823 904,6 3618,4 3048 949,6 3798,4

2824 904,8 3619,2 3049 949,8 3799,2

2825 905 3620 3050 950 3800

2826 905,2 3620,8 3051 950,2 3800,8

2827 905,4 3621,6 3052 950,4 3801,6

2828 905,6 3622,4 3053 950,6 3802,4

2829 905,8 3623,2 3054 950,8 3803,2

2830 906 3624 3055 951 3804

2831 906,2 3624,8 3056 951,2 3804,8

2832 906,4 3625,6 3057 951,4 3805,6

2833 906,6 3626,4 3058 951,6 3806,4

2834 906,8 3627,2 3059 951,8 3807,2

2835 907 3628 3060 952 3808

2836 907,2 3628,8 3061 952,2 3808,8

2837 907,4 3629,6 3062 952,4 3809,6

2838 907,6 3630,4 3063 952,6 3810,4

2839 907,8 3631,2 3064 952,8 3811,2

2840 908 3632 3065 953 3812

2841 908,2 3632,8 3066 953,2 3812,8

2842 908,4 3633,6 3067 953,4 3813,6

2843 908,6 3634,4 3068 953,6 3814,4

2844 908,8 3635,2 3069 953,8 3815,2

2845 909 3636 3070 954 3816

2846 909,2 3636,8 3071 954,2 3816,8

2847 909,4 3637,6 3072 954,4 3817,6

2848 909,6 3638,4 3073 954,6 3818,4

2849 909,8 3639,2 3074 954,8 3819,2
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Uplink CH (TX) Freq (MHz) VCO (MHz) Downlink CH (RX) Freq (MHz) VCO (MHz)

2850 910 3640 3075 955 3820

2851 910,2 3640,8 3076 955,2 3820,8

2852 910,4 3641,6 3077 955,4 3821,6

2853 910,6 3642,4 3078 955,6 3822,4

2854 910,8 3643,2 3079 955,8 3823,2

2855 911 3644 3080 956 3824

2856 911,2 3644,8 3081 956,2 3824,8

2857 911,4 3645,6 3082 956,4 3825,6

2858 911,6 3646,4 3083 956,6 3826,4

2859 911,8 3647,2 3084 956,8 3827,2

2860 912 3648 3085 957 3828

2861 912,2 3648,8 3086 957,2 3828,8

2862 912,4 3649,6 3087 957,4 3829,6

2863 912,6 3650,4 3088 957,6 3830,4
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A/D-converter Analogue-to-digital converter

ACI Accessory Control Interface

ADC Analogue-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BA Board Assembly

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic (type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2, UEME and Zocus

CCP Compact Camera Port

CDMA Code division multiple access

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSD Circuit-switched data

CSR Cambridge silicon radio

CSTN Colour Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analogue converter

DAC Digital-to-analogue converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo
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DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package

DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DTM Dual Transfer Mode

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evolution

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compatibility

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FM Frequency Modulation

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HSDPA High-speed downlink packet access

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity
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IR Infrared

IrDA Infrared Data Association

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

MP3 Compressed audio file format developed by Moving Picture Experts Group

MTP Multipoint-to-point connection

NFC Near field communication

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architecture

OMAP Operations, maintenance, and administration part

Opamp Operational Amplifier

PA Power amplifier

PCM Pulse Code Modulation

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board
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PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RDS Radio Data Service

RF Radio Frequency

RF PopPort ™ Reduced function PopPort ™  interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multimedia Card

RSS Web content Syndication Format

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noise ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCP/IP Transmission control protocol/Internet protocol

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPnP Universal Plug and Play

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC
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USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

VF View Finder

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WCDMA Wideband code division multiple access

WD Watchdog

WLAN Wireless local area network

XHTML Extensible hypertext markup language

Zocus Current sensor (used to monitor the current flow to and from the battery)
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